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Product Description

The EPC3000 range of  programmable single loop process and 
temperature controllers maximizes efficiency and repeatability and 
is certified for cybersecurity communications robustness.
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• Process inputs are fast and accurate, 
with exceptional thermal stability, 
aiding precise and consistent control 
over long periods without calibration 
drift.

• Eurotherm’s first controller to be 
designed and certified to meet the 
stringent cybersecurity requirements 
of  Achilles® Communications 
Robustness Testing Level 1.
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Character Sets Supported

Character Sets Supported

ISO 10646 (UTF-8) X

ISO 10646 (USC-2)

ISO 10646 (USC-4)

ISO 8859-1

IBM™ Microsoft™ DBCS

JIS S 0208
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Indicating support for multiple character sets does not imply that they can all be supported simultaneously.
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BACnet Interoperability Building Blocks (BIBBs) Support

BIBB Description B-ASC

Product 
Conformance

DS-RP-A ReadProperty-A

DS-RP-B ReadProperty-B X P

DS-RPM-A ReadPropertyMultiple-A

DS-RPM-B ReadPropertyMultiple-B

DS-RPC-A ReadPropertyCondiftional-A

DS-RPC-B ReadPropertyCondiftional-B

DS-WP-A WriteProperty-A

DS-WP-B WriteProperty-B X P

DS-WPM-A WritePropertyMultiple-A

DS-WPM-B WritePropertyMultiple-B

DS-COV-A COV-A

DS-COV-B COV-B

DS-COVP-A COVP-A

DS-COVP-B COVP-B

DS-COVU-A COV-Unsolicited-A

DS-COVU-B COV-Unsolicited-B

DS-V-A View-A

DS-M-A Modify-A

DS-AV-A Advanced View-A

DS-AM-A Advanced Modify-A

Data Sharing
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BACnet Interoperability Building Blocks (BIBBs) Support (continued)

BIBB Description B-ASC

Product 
Conformance

AE-N-A Notification A

AE-N-I-B Notification Internal-B

AE-N-E-B Notification External-B

AE-ACK-A ACK-A

AE-ACK-B ACK-B

AE-ASUM-A Alarm Summary-A

AE-ASUM-B Alarm Summary-B

AE-ESUM-A Enrolment Summary-A

AE-ESUM-B Enrolment Summary-B

AE-INFO-A Information-A

AE-INFO-B Information-B

AE-LS-A LifeSaftey-A

AE-LS-B LifeSaftey-B

AE-AS-A Alarm Summary-A

AE-VN-A View Notification-A

AE-VM-A View Modify-A

AE-AVM-A Advanced View Modify-A

AE-AVN-A Advanced View Notification-A

AE-ELVM-A Event Log View and Modify-A

Alarm and Events
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BACnet Interoperability Building Blocks (BIBBs) Support (continued)

BIBB Description B-ASC

Product 
Conformance

SCHED-I-B Notification A

SCHED-E-B Notification Internal-B

SCH-VM-A Notification External-B

SCH-AVM-A ACK-A

SCHED-WS-A ACK-B

SCHED-WS-I-B Alarm Summary-A

SCHED-R-B Alarm Summary-B

Schedules

©
 2

01
8 

S
c

h
n

e
id

e
r 

E
le

c
tr

ic
. A

ll 
ri

g
h

ts
 r

e
se

rv
e

d
.

BIBB Description B-ASC

Product 
Conformance

T-VMT-I-B Viewing and Modifying Trends 
Internal-B

T-VMT-E-B Viewing and Modifying Trends 
External-B

T-ATR-A Automated Trend Retrieval-A

T-ATR-B Automated Trend Retrieval-B

T-V-A View-A

T-A-A Archiving-A

T-AVM-A Advanced View and Modify-A

Trends
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BACnet Interoperability Building Blocks (BIBBs) Support (continued)

BIBB Description B-ASC

Product 
Conformance

DM-DDB-A Dynamic Device Binding-A

DM-DDB-B Dynamic Device Binding-B X P

DM-DOB-A Dynamic Object Binding-A

DM-DOB-B Dynamic Object Binding-B X P

DM-DCC-A Device Communication Control-A

DM-DCC-B Device Communication Control-B X P

DM-PT-A Private Transfer-A

DM-PT-B Private Transfer-B

DM-TM-A Text Message-A

DM-TM-B Text Message-B

DM-TS-A Time Synchronization-A

DM-TS-B Time Synchronization-B

DM-UTC-A UTCTime Synchronization-A

DM-UTC-B UTCTime Synchronization-B

DM-RD-A Reinitialize Device-A

DM-RD-B Reinitialize Device-B

DM-BR-A Backup and Restore-A

DM-BR-B Backup and Restore-B

DM-R-A Restart-A

DM-R-B Restart-B

DM-LM-A List Manipulation-A

DM-LM-B List Manipulation-B

DM-OCD-A Object Creation and Deletion-A

DM-OCD-B Object Creation and Deletion-B

DM-VT-A Virtual Terminal-A

DM-VT-B Virtual Terminal-B

DM-ANM-A Automatic Network Mapping-A

DM-ADM-A Automatic Device Mapping-A

DM-ATS-A Automatic Time Synchronization

DM-MTS-A Manual Time Synchronization

Device Management

BIBB Description B-ASC

Product 
Conformance

NM-CE-A Connection Establishment-A

NM-CE-B Connection Establishment-B

NM-RC-A Router Configuration-A

NM-RC-B Router Configuration-B

Network Management
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BACnet Standard Object Types Supported

Object Identifier Object name Description
Active/Inactive
text Access Notes

Binary Input #1 IO.IO1.Output Indicates status of  IO1 out ON/OFF R 2

Binary Input #2 IO.IO2.Output Indicates status of  IO2 out ON/OFF R 2

Binary Input #3 IO.OP3.Output Indicates status of  OP3 out ON/OFF R

Binary Input #4 IO.IO4.Output Indicates status of  IO4 out ON/OFF R 1,2

Binary Input #5 OptionDIO.D1.Out Indicates status of  D1 out ON/OFF R 1,2,3

Binary Input #6 OptionDIO.D2.Out Indicates status of  D2 out ON/OFF R 1,2,3

Binary Input #7 OptionDIO.D3.Out Indicates status of  D3 out ON/OFF R 1,2,3

Binary Input #8 OptionDIO.D4.Out Indicates status of  D4 out ON/OFF R 1,2,3

Binary Input #9 Alarm.1.Output Alarm 1 Output state ON/OFF R

Binary Input #10 Alarm.2.Output Alarm 2 Output state ON/OFF R

Binary Input #11 Alarm.3.Output Alarm 3 Output state ON/OFF R

Binary Input #12 Alarm.4.Output Alarm 4 Output state ON/OFF R

Binary Input #13 Alarm.5.Output Alarm 5 Output state ON/OFF R

Binary Input #14 Alarm.6.Output Alarm 6 Output state ON/OFF R

Binary Input #15 Programmer.Run.Event1 Programmer Event 1 ON/OFF R 4

Binary Input #16 Programmer.Run.Event2 Programmer Event 2 ON/OFF R 4

Binary Input #17 Programmer.Run.Event3 Programmer Event 3 ON/OFF R 4

Binary Input #18 Programmer.Run.Event4 Programmer Event 4 ON/OFF R 4

Binary Input #19 Programmer.Run.Event5 Programmer Event 5 ON/OFF R 4

Binary Input #20 Programmer.Run.Event6 Programmer Event 6 ON/OFF R 4

Binary Input #21 Programmer.Run.Event7 Programmer Event 7 ON/OFF R 4

Binary Input #22 Programmer.Run.Event8 Programmer Event 8 ON/OFF R 4

Binary Input Object Instance
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NOTES: 

1. Not in service on EPC3016

2. Only in service if  hardware is fitted

3. Only in service if  configured

4. Only in service if  feature enabled
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BACnet Standard Object Types Supported (continued)

Object Identifier Object name Description Units Access Notes

Analog Input #1 AI.1.Main.PV Analogue Input 1 PV — R

Analog Input #2 AI.2.Main.PV Analogue Input 2 PV — R 1,2,4

Analog Input #3 Alarm.1.Input Alarm 1 Input — R

Analog Input #4 Alarm.2.Input Alarm 2 Input — R

Analog Input #5 Alarm.3.Input Alarm 3 Input — R

Analog Input #6 Alarm.4.Input Alarm 4 Input — R

Analog Input #7 Alarm.5.Input Alarm 5 Input — R

Analog Input #8 Alarm.6.Input Alarm 6 Input — R

Analog Input #9 Loop.Main.WorkingSP Loop Working Setpoint — R

Analog Input #10 Loop.Main.WorkingOutput Loop Working Output % R

Analog Input #11 IO.LA.PV IO LA PV — R

Analog Input #12 IO.LB.PV IO LB PV — R 1

Analog Input #13 Programmer.Run.PSP Programmer Setpoint — R 4

Analog Input #14 Programmer.Run.ProgramTimeLeft Program Time Remaining ms R 4

Analog Input #15 Programmer.Run.SegmentTimeLeft Segment Time Remaining ms R 4

Analog Input #16 Programmer.Run.ProgramCyclesLeft Program Cycles Remaining — R 4

Analog Input #17 Programmer.Run.CurrentProgramNumber Current Program Number — R 4

Analog Input #18 Programmer.Run.SegmentNumber Current Segment Number — R 4

Analog Input #19 Math.1.Out Math 1 Output — R 4

Analog Input #20 Math.2.Out Math 2 Output — R 4

Analog Input #21 Math.3.Out Math 3 Output — R 4

Analog Input #22 Math.4.Out Math 4 Output — R 4

Analog Input #23 Math.5.Out Math 5 Output — R 4

Analog Input #24 Math.6.Out Math 6 Output — R 4

Analog Input #25 Math.7.Out Math 7 Output — R 4

Analog Input #26 Math.8.Out Math 8 Output — R 4

Analog Input Object Instance
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NOTES: 

1. Not in service on EPC3016

2. Only in service if  hardware is fitted

3. Only in service if  configured

4. Only in service if  feature enabled
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BACnet Standard Object Types Supported (continued)

Object Identifier Object name Description Units Access Notes

Analog Value #1 Alarm.1.Threshold Alarm 1 Threshold — W

Analog Value #2 Alarm.1.Hysteresis Alarm 1 Hysteresis — W

Analog Value #3 Alarm.1.Deviation Alarm 1 Deviation — W

Analog Value #4 Alarm.1.Reference Alarm 1 Reference — W

Analog Value #5 Alarm.1.Inhibit Alarm 1 Inhibit — W

Analog Value #6 Alarm.1.Ack Alarm 1 Ack — W

Analog Value #7 Alarm.2.Threshold Alarm 2 Threshold — W

Analog Value #8 Alarm.2.Hysteresis Alarm 2 Hysteresis — W

Analog Value #9 Alarm.2.Deviation Alarm 2 Deviation — W

Analog Value #10 Alarm.2.Reference Alarm 2 Reference — W

Analog Value #11 Alarm.2.Inhibit Alarm 2 Inhibit — W

Analog Value #12 Alarm.2.Ack Alarm 2 Ack — W

Analog Value #13 Alarm.3.Threshold Alarm 3 Threshold — W

Analog Value #14 Alarm.3.Hysteresis Alarm 3 Hysteresis — W

Analog Value #15 Alarm.3.Deviation Alarm 3 Deviation — W

Analog Value #16 Alarm.3.Reference Alarm 3 Reference — W

Analog Value #17 Alarm.4.Inhibit Alarm 4 Inhibit — W

Analog Value #18 Alarm.3.Ack Alarm 3 Ack — W

Analog Value #19 Alarm.4.Threshold Alarm 4 Threshold — W

Analog Value #20 Alarm.4.Hysteresis Alarm 4 Hysteresis — W

Analog Value #21 Alarm.4.Deviation Alarm 4 Deviation — W

Analog Value #22 Alarm.4.Reference Alarm 4 Reference — W

Analog Value #23 Alarm.4.Inhibit Alarm 4 Inhibit — W

Analog Value #24 Alarm.4.Ack Alarm 4 Ack — W

Analog Value #25 Alarm.5.Threshold Alarm 5 Threshold — W

Analog Value #26 Alarm.5.Hysteresis Alarm 5 Hysteresis — W

Analog Value #27 Alarm.5.Deviation Alarm 5 Deviation — W

Analog Value #28 Alarm.5.Reference Alarm 5 Reference — W

Analog Value #29 Alarm.5.Inhibit Alarm 5 Inhibit — W

Analog Value #30 Alarm.5.Ack Alarm 5 Ack — W

Analog Value #31 Alarm.6.Threshold Alarm 6 Threshold — W

Analog Value #32 Alarm.6.Hysteresis Alarm 6 Hysteresis — W

Analog Value #33 Alarm.6.Deviation Alarm 6 Deviation — W

Analog Value #34 Alarm.6.Reference Alarm 6 Reference — W

Analog Value #35 Alarm.6.Inhibit Alarm 6 Inhibit — W

Analog Value #36 Alarm.6.Ack Alarm 6 Ack — W

Analog Value #37 Loop.Main.PV Loop PV — W

Analog Value #38 Loop.Main.TargetSP Loop Target Setpoint — W

Analog Value #39 Loop.Main.AutoMan Loop Auto/Manual — W

Analog Value #40 Loop.OP.ManualOP Loop Manual Output — W

Analog Value #41 Loop.PID.Ch1PropBand Loop Channel 1 Prop Band — W

Analog Value #42 Loop.PID.Ch2PropBand Loop Channel 2 Prop Band — W

Analog Value Object Instance
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NOTES:  See notes 1 to 4 on previous page
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BACnet Standard Object Types Supported (continued)

Object Identifier Object name Description Units Access Notes

Analog Value #43 Loop.PID.IntegralTime Loop Integral Time — W

Analog Value #44 Loop.PID.DerivativeTime Loop Derivative Time — W

Analog Value #45 IO.IO1.PV IO IO1 PV — W 2

Analog Value #46 IO.IO2.PV IO IO2 PV — W 2

Analog Value #47 IO.OP3.PV IO OP3 PV — W

Analog Value #48 IO.IO4.PV IO IO4 PV — W 1,2

Analog Value #49 OptionDIO.D1.PV OptionDIO D1 PV — W 1

Analog Value #50 OptionDIO.D2.PV OptionDIO D2 PV — W 1

Analog Value #51 OptionDIO.D3.PV OptionDIO D3 PV — W 1

Analog Value #52 OptionDIO.D4.PV OptionDIO D4 PV — W 1

Analog Value #53 RemoteInput.Input RemoteInput Input — W

Analog Value #54 UserParameter.1.Address User Parameter 1 Address — W

Analog Value #55 UserParameter.1.Value User Parameter 1 Value — W

Analog Value #56 UserParameter.2.Address User Parameter 2 Address — W

Analog Value #57 UserParameter.2.Value User Parameter 2 Value — W

Analog Value #58 UserParameter.3.Address User Parameter 3 Address — W

Analog Value #59 UserParameter.3.Value User Parameter 3 Value — W

Analog Value #60 UserParameter.4.Address User Parameter 4 Address — W

Analog Value #61 UserParameter.4.Value User Parameter 4 Value — W

Analog Value #62 UserParameter.5.Address User Parameter 5 Address — W

Analog Value #63 UserParameter.5.Value User Parameter 5 Value — W

Analog Value #64 UserParameter.6.Address User Parameter 6 Address — W

Analog Value #65 UserParameter.6.Value User Parameter 6 Value — W

Analog Value #66 UserParameter.7.Address User Parameter 7 Address — W

Analog Value #67 UserParameter.7.Value User parameter 7 Value — W

Analog Value #68 UserParameter.8.Address User parameter 8 Address — W

Analog Value #69 UserParameter.8.Value User parameter 8 Value — W

Analog Value #70 UserParameter.9.Address User parameter 9 Address — W

Analog Value #71 UserParameter.9.Value User parameter 9 Value — W

Analog Value #72 UserParameter.10.Address User parameter 10 Address — W

Analog Value #73 UserParameter.10.Value User parameter 10 Value — W

Analog Value #74 UserParameter.11.Address User parameter 11 Address — W

Analog Value #75 UserParameter.11.Value User parameter 11 Value — W

Analog Value #76 UserParameter.12.Address User parameter 12 Address — W

Analog Value #77 UserParameter.12.Value User parameter 12 Value — W

Analog Value #78 UserParameter.13.Address User parameter 13 Address — W

Analog Value #79 UserParameter.13.Value User parameter 13 Value — W

Analog Value #80 UserParameter.14.Address User parameter 14 Address — W

Analog Value #81 UserParameter.14.Value User parameter 14 Value — W

Analog Value #82 UserParameter.15.Address User parameter 15 Address — W

Analog Value #83 UserParameter.15.Value User parameter 15 Value — W

Analog Value #84 UserParameter.16Address User parameter 16 Address — W

Analog Value Object Instance (continued)
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NOTES:  See notes 1 to 4 on following page
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BACnet Standard Object Types Supported (continued)

Object Identifier Object name Description Units Access Notes

Analog Value #85 UserParameter.16.Value User Parameter 16 Value — W

Analog Value #86 UserParameter.17.Address User Parameter 17 Address — W

Analog Value #87 UserParameter.17.Value User Parameter 17 Value — W

Analog Value #88 UserParameter.18.Address User Parameter 18 Address — W

Analog Value #89 UserParameter.18.Value User Parameter 18 Value — W

Analog Value #90 UserParameter.19.Address User Parameter 19 Address — W

Analog Value #91 UserParameter.19.Value User Parameter 19 Value — W

Analog Value #92 UserParameter.20.Address User Parameter 20 Address — W

Analog Value #93 UserParameter.20.Value User Parameter 20 Value — W

Analog Value #94 UserParameter.21.Address User Parameter 21 Address — W

Analog Value #95 UserParameter.21.Value User Parameter 21 Value — W

Analog Value #96 UserParameter.22.Address User Parameter 22 Address — W

Analog Value #97 UserParameter.22.Value User Parameter 22 Value — W

Analog Value #98 UserParameter.23.Address User Parameter 23 Address — W

Analog Value #99 UserParameter.23.Value User Parameter 23 Value — W

Analog Value #100 UserParameter.24.Address User Parameter 24 Address — W

Analog Value #101 UserParameter.24.Value User Parameter 24 Value — W

Analog Value #102 UserParameter.25.Address User Parameter 25 Address — W

Analog Value #103 UserParameter.25.Value User Parameter 25 Value — W

Analog Value #104 UserParameter.26.Address User Parameter 26 Address — W

Analog Value #105 UserParameter.26.Value User Parameter 26 Value — W

Analog Value #106 UserParameter.27.Address User Parameter 27 Address — W

Analog Value #107 UserParameter.27.Value User Parameter 27 Value — W

Analog Value #108 UserParameter.28.Address User Parameter 28 Address — W

Analog Value #109 UserParameter.28.Value User Parameter 28 Value — W

Analog Value #110 UserParameter.29.Address User Parameter 29 Address — W

Analog Value #111 UserParameter.29.Value User Parameter 29 Value — W

Analog Value #112 UserParameter.30.Address User Parameter 30 Address — W

Analog Value #113 UserParameter.30.Value User Parameter 30 Value — W

Analog Value #114 Programmer.Run.ProgramNumber Program Number — W 4

Analog Value #115 Programmer.Run.ProgramMode Program Mode — W 4

Analog Value #116 Programmer.Run.ProgramAdvance Program Advance — W 4

Analog Value Object Instance (continued)
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NOTES: 

1. Not in service on EPC3016

2. Only in service if  hardware is fitted

3. Only in service if  configured

4. Only in service if  feature enabled
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BACnet Standard Object Types Supported (continued)

Object Identifier Object name Description Units Access Notes

MSI #1 AI.1.PVStatus AI 1 Status — R

MSI #2 AI.2.PVStatus AI 2 Status — R 1,2,4

MSI #3 Alarm.1.Status Alarm 1 Status — R

MSI #4 Alarm.2.Status Alarm 2 Status — R

MSI #5 Alarm.3.Status Alarm 3 Status — R

MSI #6 Alarm.4.Status Alarm 4 Status — R

MSI #7 Alarm.5.Status Alarm 5 Status — R

MSI #8 Alarm.6.Status Alarm 6 Status — R

Multi State Input Object Instance
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NOTES: 

1. Not in service on EPC3016

2. Only in service if  hardware is fitted

3. Only in service if  configured

4. Only in service if  feature enabled
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BACnet Standard Object Types Supported (continued)

NOTE: For Present Value Access Types, R = Read-only, W = Writeable, C = Commandable

Additional functions

Besides the services of  “datasharing” the EPC3000 Programmable Controller provides the following functions:

EPC3000 Modbus address map can be found in the Eurotherm iTools help file by navigating to: 

Help>Device Help>Scada from iTools Engineering Studio when connected to an instrument or loading the relevant clone file  
(New File>EPC3000>EPC30xx Vx.xx). 

iTools can be downloaded for free from the Eurotherm website www.eurotherm.com/itools
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Full numeric parameters access:

By the use of  indirect access, it is possible to read or write any of  the internal EPC3000 numeric operator parameters, 
except 32-bit integer values. It is not possible to write to configuration parameters, or to put the instrument into 
configuration mode via BACnet communications. Integer values that can be accessed will have a resolution of  “1.0”.

This functionality is provided by the Analog Value parameter objects:

UserParameter.n.Address, UserParameter.n.Value.(n = 1 to 30)

Reading a parameter:

Write the Modbus address of  the parameter to the present value property of  the address object.

The current value of  the parameter can be read in the present value property of  the value object.

Writing a parameter:

Write the Modbus address of  the parameter to the present value property of  the address object.

Write the new value in the present value property of  the value object.

https://www.eurotherm.com/itools
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Property (R) Required
(O) Optional

(R) Read-Only
(W) Writable

Object-Identifier R R

Object-Name R R

Object-Type R R

Present-Value R W

Description O R

Status-Flags R R

Event-State R R

Out-of-Service R W

Polarity R R

Reliability O R

Binary Input Object

Property (R) Required
(O) Optional

(R) Read-Only
(W) Writable

Object-Identifier R R

Object-Name R R

Object-Type R R

Present-Value R W

Description O R

Status-Flags R R

Event-State R R

Out-of-Service R W

Units R R

Analog Value Object

Property (R) Required
(O) Optional

(R) Read-Only
(W) Writable

Object-Identifier R R

Object-Name R R

Object-Type R R

Present-Value R W

Description O R

Device Type O R

Status-Flags R R

Event-State R R

Reliability O R

Out-of-Service R W

Units R R

Analog Input Object

Object Properties Supported



Object Properties Supported (continued)

Document Number HA033299 Issue 2

Property (R) Required
(O) Optional

(R) Read-Only
(W) Writable

Object-Identifier R R

Object-Name R R

Object-Type R R

System-Status R R

Vendor-Name R R

Vendor-Identifier R R

Model-Name R R

Firmware-Revision R R

Application-Software-Revision R R

Description O R

Protocol-Version R R

Protocol-Revision R R

Protocol-Services-Supported R R

Protocol-Object-Types-Supported R R

Object-List R R

Max-APDU-Length-Accepted R R

Segmentation-Supported R R

APDU-Timeout R R

Number-Of-APDU-Retries R R

Device-Address-Binding R R

Database-Revision R R

Profile-Name O R

Device Object
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NOTE: 

Object-Name property is a combination of  the EPC3000 internal parameters “Type” and “CustomerID”. This property is read 
only and can only be changed by modifying the CustomerID parameter via iTools or HMI.

Property (R) Required
(O) Optional

(R) Read-Only
(W) Writable

Object-Identifier R R

Object-Name R R

Object-Type R R

Present-Value R W

Description O R

Status-Flags R R

Event-State R R

Out-of-Service R W

Number of  States R R

State Text O R

Reliability O R

Multi State Input Object


